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Release Notes

Integrated Dell Remote Access Controller 7 (iDRAC7)

IDRACY is a systems management hardware and software solution that provides remote management
capabilities, crashed system recovery, and power control functions for Dell PowerEdge systems.

Lifecycle Controller 2 Remote Services (LC2-RS)

LC2-RS provides advanced embedded systems management and is delivered as part of iDRAC7. LC2-RS
enables remote systems management in a one-to-many method. Remote Services uses WS-
Management (WS-MAN) protocol based Web services interface to remotely provision and manage the
servers.

Version
iDRAC7 1.40.40
LC21.15

Release Date
June 2013

Previous Version
iDRAC7 1.37.35
LC2111

Importance

URGENT: Dell highly recommends applying this update as soon as possible. The update contains
changes to improve the reliability and availability of your Dell system.

Platform(s) Affected

IDRACY and LC2-RS is supported on the following systems:

e Powerkdge T320

e Powerkdge R320

e Powerkdge T420

e Powerkdge R420

e PowerEdge M420

e PowerEdge R520

e PowerEdge M520

e PowerEdge T620

e PowerEdge R620

e PowerkEdge M620

e Powerkdge R720

e Powerkdge R720xd
e Powerkdge R820

e PowerEdge M820

e DCS2210

e Compellent SC8000



What is Supported?

Supported Managed Server Operating Systems for iDRAC7

The following operating systems support iDRACY:

Windows 8 (x64 only)

Windows Server 2008 R2 (x64 with Hyper-V)

Windows Server 2008 R2 SP1 (x64 with Hyper-V)
Windows Server 2008 SP2 (x86 and x64)

Windows Small Business Server 2011 (x64)

Windows 2012 Essentials

SUSE Linux Enterprise Server (SLES) version 10 SP4 x86_64
SUSE Linux Enterprise Server (SLES) version 11 SP2 x86_64
Red Hat Enterprise Linux (RHEL) version 5.8

Red Hat Enterprise Linux (RHEL) version 5.9

Red Hat Enterprise Linux (RHEL) version 6.1

Red Hat Enterprise Linux (RHEL) version 6.3

Red Hat Enterprise Linux (RHEL) version 6.4 (x64)

Red Hat Enterprise Virtualization (RHEV) version 3.0
Red Hat Enterprise Virtualization (RHEV) Hypervisor 6.4
ESXi version 5.0 Ul

ESXi version 5.0 U2

ESXi version 5.1

ESXi version 5.1 Ul

ESX/ESXi version 4.1 U3

Mac OS X 10.7 (Lion)

XenServer version 6.1.1

Supported Management Station Operating Systems and Web Browsers
for iDRAC7

Microsoft Internet Explorer 8 on Windows 2003 SP2

Microsoft Internet Explorer 9 on Windows Server 2008, Windows Server 2008 (x64), Windows
Server 2008 R2 (x64) and Windows 7(x86 and x64)

Microsoft Internet Explorer 10 on Windows 7 (x86 and x64), Windows Server 2012 also known as
Windows 8 (x86 and x64), Windows Server 2008 (x86 and x64), and Windows Server 2008 R2
(x64)

Mozilla Firefox 15 and 16 on Windows 7 (x86 and x64), Windows Server 2012 also known as
Windows 8 (x86 and x64), Mac OS X Lion (10.7), Windows 2003 SP2, Windows Server 2008,
Windows Server 2008 (x86 and x64), and Windows Server 2008 R2 (x64)

Mozilla Firefox 20 on Windows 2012 Essentials.

Google Chrome on Windows Server 2012 also known as Windows 8 (x86 and x64), Google
Chrome 25 and Google chrome 26 on Windows 2012 Essentials

Safari 5.2 on Mac OS X Lion (10.7), Safari 6.0 on Mac OS (10.7)

Native Mozilla Firefox on SLES 10 SP4, SLES 11 SP2, RHEL 5.8 (x86 and x64), RHEL 5.9 (x86 and
x64), RHEL 6.2, RHEL 6.3, and RHEL 6.4(x86 and x64)



What's New

iDRAC7

Support for the following new network cards:

—  Broadcom 57840S Quad Port 10G SFP+ Rack NDC supported on R820, R720, R720xd, R620
PowerEdge systems.

—  Broadcom 57840S-k Quad Port 10GbE Blade KR NDC supported on M620 and M820 PowerEdge
systems

Support for new Intel General Purpose Graphics Processing Unit (GPGPU) cards.

Support for new AMULET HOTKEY Mezzanine video card on M420, M520, and M620 blade servers.
Support for the following new Sandy Bridge processor on M620 blade server:

—  SandyBridge-EP M-0 10MB 4c FCLGA 3.3GHz STD 130W C

For the 12th generation PowerEdge systems shipping with eMMC 2 GB card that has JEDEC 4.5 standard,
the minimum supported iDRACY version is 1.40.40.

iDRAC7 - Fixes

BITS046365: RACADM hardware inventory command for Fibre Channel card does not display
operating system driver version of QLE2662 Dual Port FC16 HBA card.

BITS066684: The Hardware Inventory section in the iDRACY7 Web interface > System Inventory
page does not display the World Wide Node Name for Broadcom 57840 Quad Port Rack
Converged Network Daughter Card

BITS064704: Hardware Inventory is not displayed when M520 blade server has Broadcom 5719
QP 1G and 57810S DP 10G KR Mezzanine cards.

BITS069466: Cannot create or view the BIOS profile from Chassis Management Controller Web
interface, when the IP Range feature is enabled in the iDRACY Web interface > Network page of
a blade server.

BITS070272: Cannot launch the iDRAC7 Web interface/Remote Console from CMC Web
interface for blade servers.

BITS063021: Maximum threshold for Temperature is displayed as 125 degrees Centigrade, in the
CMC Web interface > Chassis Overview page, for M520 blade server.

BITSO70961: Exit Code returned as zero instead of non-zero value, after configuring
IDRACY with a modified configuration file using RACADM.

BITS072156: When a non-redundant power supply is used in the system and during POST if
the Enabling Fan offset option is set to any setting other than default, the Fan redundancy lost
SEL event generated and the LCD turns amber.

BITS0O74428: Network Devices Page in iDRACY Web interface displays NIC partition status,
for a Network Card that does not have support partitions.

BITS066455: Cannot launch iDRACY Web interface using iDRAC IP address due to
webserver failure

BITSO78114:. Adding Brocade 1020 adapter to the system does not increase the fan speed.

BITS076103: If French language settings are enabled in Intermet Explorer and FireFox browser,
the Power/Thermal menu information in Server page in the iDRAC7 Web interface is not
displayed.

BITS074437: Virtual MAC address i1s marked as default instead of Physical MAC address for all
network ports in the Network Devices Page in the iDRACY Web interface.

BITSO70083: In the iDRACY Web interface > Troubleshooting page > Diagnostics section,
clicking "Reset iDRAC" does not reset the iDRACY.

BITS069769: iDRACY logged events generated after enabling Remote Sys Log feature using
RACADM or iDRACY Web interface may lead to instability in the iDRAC7Y behavior.



BITS071429: "Card Type" in [/O Mezzanine Card section in the iDRAC7 Web interface > Details
page for 5719 QP 1G Broadcom card is invalid.

BITSQ77497: Enabling Power Supply Unit Status sensors on a non PMBus system, using
OPENIPMI library, causes server LCD to blink amber and SEL entries are created for false PSU
presence and PSU loss.

BITSO75559: Cannot launch the iDRACY Web interface after updating the iDRACY firmware in
systems running Windows 2012 OS

BITSO77050: Support for the following BIOS attributes added in RACADM: loatEngine,
MmioAbove4G, MonitorMwait, CollaborativeCpuPerfCtrl, and InSystemCharacterization

BITSO73804: Excessive trace log entries may lead to instability in the iDRACY behavior.
BITS059787: After iDRACY reboots, cannot launch the iDRAC7 Web interface or SSH.

BITSO75465: FlexAddress is not assigned under OS, when LOMs are disabled, enabled, and
again disabled on M620 blade servers.

BITSO75521: Even if the "racadm serveraction powerdown" command is executed successfully,
the output displays an inappropriate error message.

BITSO74254: Vendor name of the network card is not displayed in the iDRACY interface >
Network Devices page.

BITS061831:: Fabric mismatch detected for Mezzanine and Network Daughter Cards and an
unknown event is logged into SEL entries on M620 blade server

BITS054201: Few details of [/O Mezzanine card are displayed in the iDRAC7 Web interface for
PowerEdge M520 or M620 blade server.

BITS055838: The Virtual Console title bar displays the an incorrect slot number of the blade
server located in the chassis.

BITSO76312: In the iDRACY Web interface, the Data BUS width, SLOT type, and Slot Length for
6GBSAS HBA is displayed as unknown.

BITS082785: Enabling the fans to run at required speed for PowerEdge servers to avoid
overheating of Brocade FC HBA BR815 card, when installed in the system.

BITS083269: Failed to power up M620 blade server after the blade server is power cycled
continuously.

BITS083495: Instability in system behavior when SNMP feature is enabled.

BITS082718: Enabling the fans to run at required speed for PowerEdge R720 server to avoid
overheating of Intel GPGPU card, when installed in the system.

iDRAC7 - Important Notes

Checksum of the iDRACY image:

- MDS5: a048040decd40e4e8331efdff1b9b946

— SHAL 212d3eca258004205da2e9f330f94b8bb2d19e8¢
License Requirements:

— Software licensing has replaced hardware licensing. For more information, see, the Dell License
Manager User's Guide.

— Lifecycle Controller features such as Auto Discovery and vFlash are now licensed. You must install the
correct licenses for Lifecycle Controller Remote Services to work properly.

Only if there is one or more network interface cards (NDC or LOM) present on the managed
system, Network Devices appears under Overview -> Hardware section in the iDRAC7 Web
interface.

When using iDRAC7 Web interface in Firefox 3.6 if the SD card is removed while partition
creation is in-progress, "The operation has been completed successfully” message is displayed.

For the Virtual Console and Virtual Media to function properly, iDRAC7 Web URL must be added
to the Local Intranet site list and the security level for the Local Intranet zone should be set to
Medium-Low. In addition, if Virtual Console and Virtual Media are configured to use Java plug-in,



then you must disable Enhanced Security Mode in Internet Explorer. If this is not possible, then
in iIDRACY, configure Virtual Console to use the ActiveX plug-in.

If the instant messenger is launched in the Virtual Console viewer with ActiveX native plug-in
and another application is started (example Notepad, WordPad, and so on) without minimizing
the Virtual Console, the instant messenger box also pops-up on other applications. This does
not happen with Java plug-in.

When a system is in POST, it is not possible to attach a vFlash partition as the first boot device.

Virtual Console Viewer from iDRACY Web interface terminates when the managed system is
restarted.

If common logging is enabled in iDRAC7, CEM storage inventory takes more than 40 minutes. If
common logging is disabled (default setting), CEM storage inventory takes up to four minutes
for the maximum configuration.

A pop-up message is not displayed to confirm if test emails are successfully sent or not.

For iDRACY Enterprise, when the Virtual Console is disabled and Virtual Media is disabled and/or
detached, the console port (default: 5900) remains open. For iDRACY Express (no Virtual Console
or Virtual Media) the console port is open.

If auto-negotiation is enabled while setting iDRACY network, 1 Gbps is not supported and you
cannot manually select it.

A USB device mounted through Virtual Media in floppy emulation mode for a Linux operating
system shows as a removable volume.

During system power operations, if the video mode changes, the message "Out of range” may
appear for a short while on the Virtual Console.

When using the Virtual Console in native console mode with "Pass all keystrokes to server”
disabled in Internet Explorer versions 8 and 9, if an F1/F2 prompt is encountered, pressing F1
displays the Virtual Console online help pop-up in addition to continuing with the system boot.

When any of the storage enclosure components are removed, the corresponding details are not
displayed. Only the name and status attributes are displayed.

When certain RAID operations are requested using WS-MAN on non-RAID cards such as, the
Dell SAS 6Gbs HBA or the Internal Tape Adapter, the operation succeeds, however the job fails
with the error message "Unable to locate device in current configuration”.

If the iIDRACY network is configured to use a shared LOM and the spanning tree is enabled on
the LOM port, WS-MAN and remote service commands may time-out in the following scenarios:

— At system reboot
— When CSIOR is running
— While entering SSM
The connectivity lost is variable. In typical cases, it is approximately:

— 40 seconds at system reboot and varies per NIC or link speed
— 20 seconds when CSIOR is running
— 40-60 seconds while entering SSM

The reason is that when spanning tree is enabled, the switch does not allow the link to re-establish the
connection after a reset until it completes checking for network loops. Server reboots reset the NIC and
disconnects the link.

Note: This does not occur while using dedicated NIC because server reboots do not affect the dedicated
NIC.

When logging in to iDRACY Web Interface using Intermet Explorer 9 and IPV6 address, the
connection may not succeed. To resolve this, make sure that in Internet Explorer -> Tools ->
Internet Options -> Connections -> LAN Settings, the Use automatic configuration script
option is cleared.

On PowerEdge systems with cabled power supply units installed (that is, PSUs which do not
provide PMBus support), power values may still be displayed in the iDRAC7 web and LCD
interfaces. Due to lack of PMBus support in the PSUs, the power values displayed on the GUI
pages, including the Overview -> Hardware -> Front Panel page, are not correct.



e Due to the independent nature of the alert processes (e-mail, SMTP, remote syslog), when
changing the licenses that affect alert features (example, email alerts for Express or remote
syslog for Enterprise) there is no guarantee of the timing of the features being activated or
deactivated when the license changes.

e Inthe iDRAC Web interface, when the System Inventory page is accessed for the first time, it
takes up to two minutes for the inventory data to be collected. After the data collection is
complete, refresh the page to display the inventory data.

e Make sure to synchronize the iDRAC time with the management station'’s time to avoid
certificate related issues. If the time is not synchronized, issues such as server certificate
expiration may be seen. If this occurs, re-synchronize iDRAC time with the management
station'’s time and reboot iIDRAC.

e On a Linux system, if you click on a menu item and it remains open, the <Ctrl> + <Alt> + <L>
keystroke sent from iDRAC to the host system does not lock the host system. The behavior is
the same as using a local keyboard.

e The default time zone value is US Central Time. To make sure Single Sign-On (SSO) and
Directory Service TFA (smart card) continue to work properly, the iDRAC time zone must match
the time zone where iIDRAC is located, assuming Active Directory server's time zone is already
configured to match the Active Directory's location. For example, if Active Directory server is
located at US Eastern time zone and iDRAC is located at US Pacific time zone, Active Directory
server has to be configured as US Eastern time zone (this is Active Directory server configuration
and is normally configured), and iDRAC must be configured as US Pacific time zone.

For more information to configure the time zone, see the iIDRACY User's Guide.

e If the management station is using MAC operating system, it takes more time to launch the
Virtual Console due to the following DNS search issue:
http://www.eigenspace.org/2011/07/fixing-osx-lion-dns-search-domains/

e From iDRACY 1.30.30 onwards, if you configure iDRAC using XML Import, the "user password is
changed” messages are seen in the Life Cycle log. An entry is seen for all local user index that
are not configured in XML file and have default values.

e The help page for the backup and restore feature does not provide the correct share name. See
the Web Services Interface Guide available at www.dell.com/support/manuals for the correct
share name.

e Remote Sys Log settings takes effect only if you do the following:
— Enable remote syslog feature
— Specify the server address and port number

— Enable Remote SysLog option on the Alerts page

iDRAC7 - Known Issues

Issue 1

Description

[n Chinese locale on Windows operating system, while launching the Virtual Console using Java plug-in,
occasionally you may see a Java compilation error.

Resolution

1. Open the Java control panel.
2. Go to General -> Network Settings.
3. Select Direct Connection and click OK.

Versions/Systems Affected
All iDRAC7Y supported Dell PowerEdge systems.



Issue 2:

Description
Known iDRACY [Pv6 limitations:
e Email alerts are not sent if the iDRACY7 DNS Domain Name is not specified when using IPv6.

e Network File Share (NFS) mounting does not work with IPv6. This applies to features such as
connecting a remote file share or exporting the Lifecycle Controller log to a network shared
location.

e Firefox versions 4.x, 6.x, and 7.x may prevent the iDRAC7 Web interface from opening when
using IPv6. For more information see: https://bugzilla.mozilla.org/show_bug.cgi?id=633001

e  On Microsoft Windows Operating Systems, when launching Virtual Console using Java plug-in
or when launching Video Capture plug-in, empty warning dialogs may appear. Continue to click
OK to launch the plug-in. This is a known limitation in Java Web Start if it's Network Settings is
set to use browser settings. To resolve this, set the Java's Network Settings to Direct Connection.

Resolution (only for logging in to iDRAC7 Web interface):

1. Register iIDRACY to DNS.

2. Make sure the client system also has this DNS in its DNS list.

3. Enable [Pv6 and disable [Pv4.

4. Log in to iDRACY using the Fully Qualified Domain Name (FQDN).

For launching Virtual Console with [Pv6 in Firefox 4.0 or later versions, from Windows management
system, run ipconfig /flushdns in the command prompt.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 3:

Description
The Learn More pop-up on the License page does not appear using IE.
Resolution

Add *.dell.com to the trusted sites in the Security settings. See the /nternet Explorer help documentation
for more information.

Versions/Systems Affected
All iDRACY supported Dell PowerEdge systems.

Issue 4:

Description

On Windows operating system, to add a folder as an image using the Virtual Media, the Desktop
directory must be in the HOMEPATH directory. The HOMEPATH directory may vary depending on the
Windows installation, but the images created from the "Add Folder as Image” operation always reside in
the %HOMEDR I VE%\%HOMEPATH%\Desktop directory. The HOMEDRIVE must be set to C drive. Otherwise,
the operation falils.

Versions/Systems Affected
All iDRACY supported Dell PowerEdge systems.

Issue 5:

Description

If the management station is using Linux operating system with the Pass all keystrokes to server option
enabled, you cannot resize the Virtual Console viewer window by dragging the corners or frame. This is
a limitation of X-Windows.



Resolution:
Do any of the following:
e Disable the Pass all keystrokes to server option.

e With Pass all keystrokes to server option enabled, open any menu in the Virtual Console viewer
window title bar, then re-size the window.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 6:

Description
vFlash functionality remains enabled after firmware update without preserving configuration.

If vFlash functionality is enabled and a firmware update is performed without preserving the
configuration (Preserve Configuration is not selected), the vFlash Enabled option remains selected.
This is a known behavior.

Resolution

You must manually enable or disable the vFlash functionality after the firmware update as required. To
do this, select or clear the vFlash Enabled option in the iIDRAC7 Web interface, or use RACADM or
WInRM remote service commands.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge(TM) systems.

Issue 7:

Description

In some scenarios, typically for state change events occurring within a span of few seconds, the
sequence of events reported in the Lifecycle Log (or corresponding SNMP traps/email alerts) for storage
devices may not exactly match the sequence in which they occurred.

Resolution

The current state or attribute of the storage device can be checked in any of the iDRACY interfaces
(example, iIDRAC7 Web interface, RACADM and so on).

Versions/Systems Affected
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 8:

Description

When enclosures connected in the redundant path are re-wired (connections are switched) to result in a
non-redundant path, the reported connected port value of the enclosures may not be accurate.

Resolution

Power cycle the server.

Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 9:

Description

When a storage enclosure is disconnected or accidentally removed, the corresponding status of its
components (that is, EMM, PSU, fan, and temperature sensors) is reported as critical.



Resolution

If the storage enclosure is disconnected accidentally, reconnect it to get back to normal state. If it is
intentional, perform iDRACY reboot or server power cycle to remove the enclosure entries from the
consoles.

Versions/Systems Affected
All Dell PowerEdge systems with IDRAC7 and out-of-band enabled PERC storage controllers.

Issue 10:

Description

Logging in to IDRAC7 Web interface fails with the error message 'RAC0218: The maximum number of
user sessions 1s reached’.

When the temporary folder used by iDRAC7 components is full, it is possible that authentication fails and
this error is displayed.

Resolution

Power cycle iDRACY to clear the temporary space.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 11:

Description

On Microsoft Windows? operating system, while launching Virtual Console in native mode using
Internet Explorer, the iDRAC7 Login page is displayed.

Virtual Console uses plug-ins and due to insufficient privileges plug-in does not load and iDRAC7 Login
page is displayed.

Resolution

Reboot operating system and log in to iIDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 12:

Description

When selecting browser buttons (forward or back), the GUI pages are not displayed correctly and
sometimes the same page re-appears.

IDRACY Web interface is a platform management application and all the necessary controls are provided
within the application. The Web browser buttons are outside of this application and may not function

properly.

Resolution

Use the navigation options within the iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.



Issue 13:

Description

When you log in to iDRACY7 Web interface using Internet Explorer 9.x, contents in few pages are not
shown properly. This is a known issue with Internet Explorer.

Resolution

1. Press <F12>. The Internet Explorer 9 Debug window is displayed.

2. Select Document Mode -> Internet Explorer 7. The browser refreshes and the iDRAC7 Login page is
displayed.

3. Close the Internet Explorer 9 Debug window.

4. Close all open Internet Explorer windows.

5. Open Internet Explorer and log in to iDRAC7.

For more information, see Internet Explorer documentation.
Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 14:

Description
When an Enterprise or Enterprise Evaluation license expires, Active Directory is disabled automatically.
Resolution

After re-installing the Enterprise or Enterprise Evaluation license, an administrative user can log in as an
existing local iDRACY user to re-enable Active Directory authentication, using any iDRACY interface such
as RACADM or the Web interface. Remote RACADM can be used in a script to batch-enable Active
Directory. If a local iIDRACY user is not enabled or is not configured for remote access, the administrative
user must use local RACADM or OpenManage Server Administrator to configure a local user.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 15:

Description

When a power reset is performed, the Virtual Console Viewer menu options (except File -> Exit and
Help options) are grayed-out or inaccessible. The 'Link interrupted’ message appears at the bottom of
Virtual Console Viewer.

Resolution

Due to a temporary network outage, the Virtual Console Viewer menu options are not accessible. The
"Link interrupted” message s displayed to indicate that an outage has occurred. This is a temporary
problem and the menu options are available when the network is restored.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 16:

Description

IDRACY Web interface does not respond when using Internet Explorer.

Resolution

Close all Internet Explorer sessions and open it again to access iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.



Issue 17:

Description

When a driver pack DUP update is performed, the following message is recorded in the Lifecycle log after
the driver pack update entry.

RAC0400: IDRAC memory low IDRAC is running low on memory. System performance may be degraded.
Recommended Action: No response action is required.
Resolution

No workaround is required. This is a normal condition when the memory is lower than the threshold for
around 30 seconds and returns to normal after the driver pack update finishes.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 18:

Description

Resetting iDRACY to default values action may take between four to six minutes to complete.
Resolution:

Wait for iDRACY to reboot before performing any other action.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 19:

Description

While deploying Windows 2008 R2 SP1 from Lifecycle Controller GUI -> OS Deployment, installation
terminates with the following error:

There is no disk in the drive. Please insert a disk into drive \Device\HarddiskO\DRO.
This issue may occur due to any of the following reasons:

e Virtual Media is in the attached state with no media mapped.

e Virtual Media is in the auto attached state with media mapped.

e Virtual Media being presented by the AVCT SIP and Virtual Media from iDRACY in the detached
state.

e The underlying cause may be due to failure to load drivers for RAID controllers on the system.

Note: It does not happen with Virtual Media in the detached state. It also does not happen without the
SIP and with Virtual Media in the detached state from iDRACY.

Resolution

Retry the operation.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 20:

Description

In the iDRACY Web interface -> Overview -> Server -> Power/Thermal -> Power Monitoring tab ->
Power section, the Power Unit selector only changes the unit of measure. Due to the oscillating nature
of power, the Present Reading cannot be displayed as units for Current (Amps).

Resolution
None.
Versions/Systems Affected



All Dell PowerEdge systems with iIDRACY.

Issue 21:

Description

On all Intel NICs, each port cannot be assigned different iSCSI initiator name (by assigning the value for
[scsilnitiatorName). If the name is changed for one port, the same change is applied to all ports.

Resolution

None.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 22:

Description

When virtual world wide name and virtual world wide port name attributes on a NIC partition are set
using the WS-MAN interface, the new values are not updated in the iDRAC7 Web interface or when
racadm getsysinfo is run

Resolution

Use WS-MAN interface to obtain the updated values for those attributes.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 23:

Description

The Predicted Capacity Status attribute of the storage controller battery reported by IDRACY interfaces
may not be accurate in some situations.

Resolution

The Predicted Capacity Status attribute has been deprecated. To view the correct battery state, use the
storage battery state/status values instead.

Versions/Systems Affected
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 24:

Description

When inventory changes are done to the storage sub-system (such as inserting and removing disk drives,
and so on) before or during POST/reboot, the corresponding events may not be recorded in Lifecycle log.
SNMP traps/email alerts may not be generated and the inventory changes may not be correctly reflected
in the iDRACY interfaces (example, iDRAC7 Web interface, RACADM and so on).

Resolution

To view the correct storage inventory data, perform a server power cycle (cold boot).
Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 25:

Description

If a NIC card, with partitioning enabled, is replaced with a similar type of card, without partitioning
enabled, the configurations from the previous card are not applied to the new card.

Resolution:



After the previous card is replaced with a new card and the system is powered on, go to OptionROM
(CTRL-R) and enable partitioning. Save, exit, and reboot the system.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 26:

Description

When using DownloadServerPublicKey or DownloadClientCerts commands in WSMAN, the invocation
may fail when the iDRAC7 system is not ready to service the operations. This may happen when host
system is in a POST stage.

Resolution

Wait until host system is past the POST stage and retry the command.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 27:

Description

When launching Virtual Console viewer using ActiveX plug-in, a blank window appears and Virtual
Console viewer does not launch.

Resolution

This may be due to incompatible binaries from a previous version. Remove temporary files from the
download location on your system (for example, C:\windows\Downloaded Program Files) and retry.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 28:

Description

When video player is launched, it launches both a playback control window and a playback window. On
a Linux RHEL6.0 workstation, if the playback window loses focus, then you cannot switch back using the
mouse.

Resolution:

This is an issue with the RHEL 6.0 version of Linux. Close the playback control window by selecting X'
and select the playback program on task bar using the mouse to display the playback window. If you
need to view the playback controls again, select its menu item from the playback window.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 29:

Description:

When running the Virtual Media client on Windows 7 or Windows Server 2008 R2, the Virtual Media
client may not be able to access a floppy disk in read-write mode because of a problem with the client
workstation operating system.

Resolution:

Apply the operating system update to the Windows 7 or Windows Server 2008 R2 client workstation
operating system as specified in the following link: http://support.microsoft.com/kb/2496290.

Versions/Systems Affected

AILIDRACY supported Dell PowerEdge systems being accessed by a Windows 7 or Windows Server 2008
R2 client workstation without the specified update applied.



Issue 30:

Description:

There is no option to eject the USB drive on SUSE Linux Enterprise Server 11. The only option to unmap
virtual USB is to force unmapping using the Virtual Media window.

Resolution:

Unmount virtual USB before forced unmapping to make sure the server has completed all the pending
tasks before the drive is unmapped.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 31:

Description:

Learn More option in the Licensing page does not work on Safari browser.
Resolution:

Disable the popup blocker for Safari browser.

Versions/Systems Affected

AILIDRACY supported Dell PowerEdge systems.

Issue 32:

Description:

Launching Virtual console using Google Chrome browser does not launch Java Web Start automatically
even after you map launch application. This is a known issue with Google Chrome browsers.

Resolution:

Map launch application to Java Web Start every time. To do this, right-click on the downloaded file, click
Open and map it to Java Web Start.

Versions/Systems Affected
AILIDRACY supported Dell PowerEdge systems.

Issue 33:

Description:

In a Linux operating system, after logging in to the iDRAC Web interface using a Firefox browser and you
launch the Virtual Console, sometimes Virtual Console window does not respond to keyboard input.

Resolution:

Close and re-launch the Virtual Console.
Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.

Issue 34:

Description:

When there is no license installed on a value line platform like T420, you cannot perform any firmware
update through iIDRAC Web interface using Dell Update Packages (DUPs). This is the correct behavior,
but the displayed error message is not correct. Error message is "LIC006: The License has expired. Obtain
a replacement license and import it.”

Resolution:

Obtain an appropriate license then try again. If the problem persists, contact the technical support. See
the product documentation to choose the contact method that is convenient for you.



Versions/Systems Affected.:
All Dell PowerEdge systems with iDRACY.

Issue 35:

Description:

[f you try to upload any other certificate other than a valid PKCS#12 format file, the iIDRAC Web interface
displays an incorrect error message.

Resolution:

Upload a valid PKCS#12 format certificate file.
Versions/Systems Affected.:

All Dell PowerEdge systems with iDRACY.

Issue 36:

Description:

On applying Delete Custom SSL Certificate when no certificate (CSC) is available, GUI displays the
message: RAC0507 Unable to find the requested resource. Do one of the following and retry the
operation:

e Turn on the system.
e Make the resource available.
Resolution:
No impact as such, the request to delete non-existent CSC results in this message.
Versions/Systems Affected.:
All Dell PowerEdge systems with iDRACY.

Issue 37:

Description:

After uploading a custom signing certificate to iDRAC and restarting iDRAC, when you log in to iDRAC
Web interface using Firefox browser, the security certificate error is displayed. This is because the serial
number of the certificate that was stored in the Firefox browser cache is the same as the serial number
of the certificate on iDRAC.

Resolution:

Remove the browser certificate in the cache and log in to the iDRAC Web interface. For information on
removing certificates, see the Firefox documentation. If the problem persists:

1. Login to iDRAC using racadm and run sslresetcfg.
2. Perform steps to upload custom signing certificate.

Issue 38:

Description

On PowerEdge M520, if a Broadcom 57810S DP 10G KR Mezz 55 GHP or Qlogic DP 10 Gb SFP+/DA CNA
Mezz RX8CJ is installed, an additional blank entry is displayed in the System Inventory page of the Web
interface and on other interfaces such as RACADM, WSMAN, and Lifecycle Controller GUL

Resolution

This is a false entry and can be ignored.
Versions/Systems Affected

Dell PowerkEdge M520



Issue 39:

Description

Sometimes invalid characters are displayed on the server console screen after exiting iDRAC Virtual
Console.

Resolution

Launch virtual console and clear the Automatic System Lock option.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 40:

Description

On PowerEdge M420 blade servers, the iDRAC GUI's WWN/MAC page reports the Al and A2 network
devices as reversed on systems in sub-slots b and d. A1 MAC addresses are reported in the A2 section of
the IDRAC GUI, and A2 MAC addresses are reported in the Al section. MAC addresses for systems in sub-
slots a and c are reported correctly. CMC versions 4.10 to 4.30 exhibit the same problem (interchanging
the MAC addresses of the Al and A2 network devices for M420 servers in sub-slots b and d).

Resolution

If using CMC 4.4 or later, see the CMC GUI for proper MAC listings. Otherwise, for sub-slots b and d,
exchange the MAC addresses read from the Al and A2 sections

Versions/Systems Affected
Dell PowerkEdge M420

Issue 41:

Description

After an IDRACY firmware update, some of the iDRACY Web interface panels or navigation menu items
may contain incorrect or invalid entries.

Resolution

Clear your browser cache(s) after updating the iDRACY firmware,
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 42:

Description

Drives that cannot be accessed may be displayed in the Virtual Media configuration menu when using
the Java plug-in. This occurs if inaccessible network shares or storage devices are configured on the
management station (for example, by the IT department).

Usually, these zero-size drives would not be displayed, but, due to a bug in iDRACY firmware, these
drives may be displayed.

Resolution

No impact as such and it can be ignored
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.



Issue 43:

Description

Credential vault contents may be erased when upgrading to or downgrading from iDRACY firmware
version 1.40.40, resulting in different symptom:s.

Resolution

Back up the Credential Vault data (uploaded certificates, and so on) before upgrading to or downgrading
from iDRAC7Y 1.40.40 firmware. After the firmware update is complete, reload the Credential Vault
contents.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 44:

Description

In the iDRAC7 Web interface > System Inventory page, the AMULET Video Mezzanine card description is
displayed as "Whistler[Radeon E6760]" and the description for Manufacturer is displayed as "Advanced
Micro Devices[AMDInee ATI".

Resolution

No impact and can be ignored.

Versions/Systems Affected

PowerEdge M420, PowerEdge M520, and PowerEdge M620 systems with iDRACY.

iDRACY7 - Limitations

e If floppy emulation is enabled when a bootable USB key is mounted as a Virtual Media from the
Virtual Console and if you try to delete any file from the mounted USB key (floppy), the blue
screen appears immediately.

e Web server session time-out is not exact. It is either 10% more or 15 seconds more, whichever is
greater.

e  WinRM and RACADM commands may become unresponsive during BIOS update or when
setting BIOS, NIC, or RAID attributes through Lifecycle Controller.

e Using WS-MAN and running up to 256 jobs through the job scheduler may lead to reduced
IDRACY performance.

e [finvalid credentials are used for the maximum login attempts, the IP is blocked for the duration
of the IP Blocking Penalty Time and a message is not displayed.

e If Internet Explorer (IE) 64-bit browser is used to log in to iDRAC7 Web interface and when
viewing the power usage graph, the X and Y axis labels appear too small to read. This is a known
limitation for IE 64-bit only.

e The labels appear correctly in IE 32-bit browser.

e On Linux management stations, if Firefox is launched from the root user, a USB key is mapped in
Virtual Media successfully. If Firefox is launched from any user other than the root user, a USB
key is not shown for mapping because the user must have root privileges to access all the low-
level drives.

e Alert notification for battery events does not work.

e  Operating system information on the System Summary page does not display after rebooting
IDRACY until the operating system is rebooted.

e {DRACY users with user names containing a semi-colon (;) cannot log in to iDRACY through SSH.

e In the IDRACY Web interface, the power consumption sensor reading may have a rounding error
of up to 13 Watts depending on the actual power reading. This is an IPMI limitation. The power
cap, power graphs, cumulative power, and peak power are not affected by this inaccuracy.



However, the power values shown in the power graphs are average values over a period of time
and should not be used to calculate instantaneous power.

e Inthe iDRACY Web interface, while viewing the CPU details under Overview -> Hardware, the
CPU status is displayed with a warning icon for a CPU that is absent and the status is blank.

e Virtual Console uses self-signed certificates. Due to this, when launching Virtual Console from
some management stations with Windows operating systems, a certificate warning appears.

e Virtual Console in dual monitor mode is not supported and hence the behavior is undefined,
especially using Java plug-in. The primary console is used as the target console.

e The e-mail address specified in iDRACY7 Web interface -> Overview -> iDRAC Settings ->
Network -> SSL -> Generate Certificate Signing Request (CSR) page is not validated.

e On a Linux management station with Matrox drivers, from the Virtual Console Viewer if you
access the iDRAC Chat window, the mouse appears flickering inside the chat window.

e Work notes can display up to 255 characters. If any of the characters are special characters or
non-alpha numeric characters, then the total number of characters displayed is less than 255 to
accommodate overriding special characters.

LC2-RS - Fixes

e BITS069452: "Backup file data processing error” is captured in the iDRACY Lifecycle Controller
Logs, as Backup server profile operation is failing.

e BITSO70479: Asset tag of IDRACY blade server is also cloned in the process of cloning blade
server BIOS profile.

e BITS069719: 'DNS DRAC NAME' is also cloned in the process of cloning BIOS profile for a blade
server from another blade server.

e BITS069766: Every cold reboot of 12GPowerEdge system causes an addition of new entry "A
replacement part was detected for device: POWER SUPPLY." In Lifecycle Controller log.

e BITS071403: Values of different attributes of Network cards were not displayed in the Hardware
inventory page in Lifecycle Controller GUI.

e BITS073682: "HOST NAME and OS details" are also cloned in the process of cloning server profile
for a blade server from another blade server's profile.

e BITS082118: Ungraceful shutdown occurs on the host system of the blade servers, when the
BIOS firmware is updated using iDRAC7 Web interface.

LC2-RS - Important Notes

e Auto Discovery messages are now recorded in the Lifecycle Log.
e Driver Pack updates no longer require a reboot.

e The Automated Task Engine screen now displays scheduled jobs with a "Running” status unlike
previous versions.

e Empty partitions are created quickly when other partitions are not in use. If other partitions are
In use, then creating an empty partition takes longer. For example, attach partition, format
partition, and so on.

e Lifecycle Controller job scheduling is enhanced. Jobs scheduled in the same group are executed
In a sequence. Jobs that are not in the same group and scheduled at the same time execute at
the scheduled time in parallel.

e Passwords included in URI strings must use the correct percent-encoding format.

e The string value for Challenge-Handshake Authentication Protocol (CHAP) passwords must
have either zero or between 12 to 16 characters.

e Changing the system password and locking the password cannot be done in a single Lifecycle
Controller job. Run a job to change the password, reboot the host, and then run another job to
lock the password.



e System Characterization must be enabled to correctly run the frmware update during system
power on after a Power Supply Unit (PSU) replacement. If System Characterization is not
enabled, the firmware update runs after the next host reboot.

e [f the system is shut down or left in the shutdown state while a job is in progress, the job cannot
progress further. Delete the job and run it again.

LC2-RS - Known Issues

Issue 1:

Description

When the status of the DUP update is checked using the WS-MAN query for the job InstancelD of the
DCIM_Lifecycledob, the 'Percentage Complete’ parameter value displays ‘NA" even though the job is in-
progress or complete.

Versions/Systems Affected
All LC2-RS supported Dell PowerEdge systems.

Issue 2:

Description

After running a BIOS or NIC job, if you pause (by pressing Pause key on keyboard) during POST and run
another BIOS or NIC job, it fails.

Versions/Systems Affected
All LC2-RS supported Dell PowerEdge systems.

Issue 3:

Description

While performing platform update using the NFS share option, if the NFS service is stopped or network
connection to the NFS share is lost while the job is in a downloading state, the job does not fail and
continues to stay in a downloading state.

Resolution

To change the job status to:
e Downloaded successfully - Restart the NFS service or re-establish the network connection.
e Failed - Reset iDRACY.

Versions/Systems Affected

All LC2-RS supported Dell PowerEdge systems.

Issue 4:

Description

When two PSUs of same wattage and make are replaced and Part Replacement (Allow Version Upgrade
only or Match firmware of replacement part option) feature is enabled, during platform update, the
following behavior is observed:

After the first PSU firmware update is complete, the Lifecycle log shows that both the PSUs are updated
even though the firmware update for the second PSU is in progress. After the second PSU firmware
update is complete, the Lifecycle log is not updated again.

Resolution

Query the job status using the job ID for the second PSU to get the correct status.
Versions/Systems Affected

All LC2-RS supported Dell PowerEdge systems.



Issue 5:

Description

LC-Remote Services jobs may fail occasionally to perform the required operations (either due to manual
intervention or system failure) and the user cannot create a new job on the same component.

Resolution

Delete all the jobs.

Versions Affected

All LC2-RS supported Dell PowerEdge systems.

Issue 6:

Description:

During POST, the message "Lifecycle Controller update required” appears at the top right of the screen.
This indicates that Lifecycle Controller is in recovery mode. This issue may occur due to Lifecycle
Controller corruption or if an earlier model of Avocent SIP is used.

Resolution:
To bring Lifecycle Controller out of recovery mode:

1. During POST, press <F2> and go to System Setup -> iDRAC Settings.
2. Under iDRAC settings, go to Lifecycle Controller and set Lifecycle Controller to Enabled.
3. Click Back, click Finish, and then click Yes.

If Lifecycle Controller continues to be in recovery mode, perform a remote Lifecycle Controller update
using WSMAN.

Issue 7:

Description

In process of Cloning BIOS profile for a blade server from another blade server, SMTP settings are not
cloned.

Resolution:

User needs to configure SMTP settings manually, after cloning of BIOS profile is completed for the blade
server.

Versions Affected
All LC2-RS supported Dell PowerEdge systems.

LC2-RS - Limitations

e Lifecycle Controller-Remote Services does not support the BootP enumeration option for
LegacyBootProto attribute. If BootP option is displayed and selected from System Setup ->
Device Settings -> Select target NIC -> Main Configuration -> MBA Configuration -> Legacy
Boot Protocol menu (press <F2> during startup to access System Setup), Lifecycle Controller-
Remote Services does not read the value and goes into error state. To recover from this error
state, go to Legacy Boot Protocol menu and revert to the supported options.

e [f the Intel NIC card has multiple ports with LegacyBootProto attribute, the
LegacyBootProto attribute value can be changed to ISCSIPrimary for only one port.



iDRAC7 - Installation

Prerequisites

Before you update iDRACY firmware using local RACADM or the Dell Update Package, perform the
following procedures. Otherwise, the firmware update operation may fail

1. Install and enable the appropriate IPMI and managed node drivers.

2. If your system is running a Windows operating system, enable and start the Windows Management
Instrumentation (WMI) service.

3. If you are using iDRACY Enterprise and your system is running SUSE Linux Enterprise Server (version 10)
for Intel EM64T, start the Raw service.

4. Disconnect and unmount Virtual Media.

5. IfiDRACY firmware update is interrupted for any reason, you must wait for at least 30 minutes before you
start the firmware update again.

Installation Instructions

e From the Windows host operating system (managed node), run the Dell Update Package for
Windows and follow the instructions on the update wizard.

e From the Linux host operating system (managed node), run the Dell Update Package for Linux
from the shell prompt. Follow the instructions displayed on the console.

e From the management station, remotely update the firmware using the iDRAC7 Web interface:

1. Extract the firmware image self-extracting file to the management station.

2. Open the IDRACY Web interface using a supported Web browser.

3. Login as administrator.

4. Go to Overview -> iDRAC Settings -> Update and Rollback -> Update. The Firmware Update
page is displayed.

5. Click Browse, select the .d7 firmware image file that you extracted (step 1), or the Dell Update
Package (DUP) for Windows, and click Upload.

6. Wait for the upload to complete. After the upload is completed, the Update Details section displays
the firmware file uploaded to iIDRAC and the status.

7. Select the firmware file and click Install or Install and Reboot. If it is a DUP, Install dynamically
changes to Install and Reboot and at the same time the Install Next Reboot is activated. When
you click Install and Reboot or Install Next Reboot, the message "Updating Job Queue” is
displayed.

8. Click OK The Job Queue page is displayed, where you can view and manage the firmware update.
After the update is completed, iDRACY restarts automatically.

For more information, see the IDRACY User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-
cntrllr-7-v1.30.30.

Upgrade

IDRACY firmware cannot be installed on platforms that support iDRAC6 and cannot be used to upgrade
IDRACSG firmware to iDRACY. For more information, see the iDRACY User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-cntrlir-7-
v1.30.30.

Uninstallation

Use the rollback feature to return to the previous installed version of iDRACY firmware.

For more information, see the IDRACY User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-cntrlir-7-
v1.30.30.



Lifecycle Controller 2 Remote Services - Client Tools

Use the WinRM and OpenWSMAN CLI client tools to send WS-MAN commands to Lifecycle Controller.

WinRM

WInRM is a Windows native WS-MAN client. It is recommended to use WinRM 2.0 on Windows
Management Stations. WinRM 2.0 is installed by default as a part of Windows 7 and Windows Server
2008 R2. It can also be installed as a part of the Windows Management Framework Core package on the
following systems:

e Windows Server 2008 SP1
e Windows Server 2008 SP2
e Windows Server 2003 SP2
e Windows Vista SP1

e Windows Vista SP2

e Windows XP SP3

For more information on how to install WinRM 2.0 as a part of the Windows Management Framework
Core package, see article 968929 in the Microsoft Knowledge Base at:

http://go.microsoft.com/fwlink/?Linkld=186253
Recommended WinRM Client Configuration:

e MaxBatchltems = 50

e MaxTimeoutms = 60000

e MaxEnvelopeSizekb = 150

e NetworkDelayms = 60000

Sample WinRM Command (Enumeration Operation):

winrm e cimv2/DCIM_SystemView?__cimnamespace=root/dcim -u:[idrac user]
-p:[idrac password] -r:https://[idrac ip adddress]/wsman -encoding:utf-8
-azbasic -SkipCNcheck -SkipCAcheck -format:Pretty

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed
certificates are not accepted by the WinRM client and WinRM commands do not work without these
options: -SkipCNcheck and —SkipCAcheck

OpenWSMAN CLI

OpenWSMAN CLI is an open source Linux WS-MAN client. OpenWSMAN CLI source code and installation
details are available at:

http://sourceforge.net/projects/openwsman/files/wsmancli

Sample OpenWSMAN CLI Command (Enumeration Operation):

wsman enumerate http://schemas.dmtf.org/wbem/wscim/1/cim-schema/2/DCIM_SystemView -h
(idrac ip adddress) -P 443 -u (idrac user) -p (idrac password) -v -j utf-8 -y basic -R -0
-m 256 -N root/dcim -c cert_name.cer -V

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed
certificates are not accepted by the OpenWSMAN CLI client and WS-MAN commands do not work
without these options: -c, -v, and -V. See the OpenWSMAN CLI readme for details on these options.



Contacting Dell

Note: If you do not have an active Internet connection, you can find contact information on your
purchase invoice, packing slip, bill, or Dell product catalog.

Dell provides several online and telephone-based support and service options. Availability varies by
country and product, and some services may not be available in your area. To contact Dell for sales,
technical support, or customer service issues:

1. Visit www.dell.com/support.

2. Select your support category.

3. Verify your country or region in the Choose a Country/Region drop-down menu at the top of page.
4. Select the appropriate service or support link based on your need.

Accessing Documents From Dell Support Site

To access the documents from Dell Support site:

1. Go to dell.com/support/manuals.

2. Inthe Tell us about your Dell system section, under No, select Choose from a list of all Dell products
and click Continue.

3. In the Select your product type section, click Software, Monitors, Electronics & Peripherals.

4. In the Choose your Dell Software, Monitors, Electronics & Peripherals section, click Software.

5. In the Choose your Dell Software section, click the required link from the following:

—  Client System Management
—  Enterprise System Management
—  Remote Enterprise System Management
—  Serviceability Tools
6. To view the document, click the required product version.

You can also directly access the documents using the following links:
e For Remote Enterprise System Management documents — dell.com/esmmanuals
e For Enterprise System Management documents — dell.com/openmanagemanuals
e For Serviceability Tools documents — dell.com/serviceabilitytools

e For Client System Management documents — dell.com/OMConnectionsClient
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